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Long-Exposure Astrophotography
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Many nature and landscape photographers have an interest in integrating the night sky into their photo portfolio. Typically, this takes the
form of star-trail photography or landscapes lit by only the moon. However, the night sky can make an excellent subject on its own,
especially with longer exposures. Adding a tracking mount and some processing techniques to your toolkit will allow you to explore this
fascinating area of photography.

Long-exposure astrophotography can cover everything from images lasting a minute to those lasting many hours and is usually the realm
of sophisticated telescopes. In order to keep this article focused on what the typical nature photographer might be interested in exploring,
the content of this article is limited to images taken with standard SLR lenses and individual exposures lasting less than ten minutes
(although | will discuss stacking of images to obtain longer effective exposures).

Topics covered:
o What equipment you will need
e Basic requirements for successful long-exposure astrophotography

e Techniques for post-capture processing

By the end of this article you will be ready to take photos like this one.

Late Summer Milky Way and Aurora, Lac du Flambeau, WI, 5 minutes, /4, ISO 800
Equipment

The Tracking Mount



While the rotation of the earth can be exploited to wonderful effect to create beautiful star trail photos, when your intent is to capture detail
in the sky you need the sky to remain still relative to the sensor in your camera. In order to accomplish this, you will need some type of
tracking mount. There are many options available, from the home-made “barn-door” mount, to expensive German equatorial mounts from
a variety of manufacturers, such as Astro-Physics, Takahashi, Losmandy, Meade and Celestron. Personally, | recommend the Kenko
SkyMemo Tracker as the best option for a relatively inexpensive, yet high-quality tracking mount. Powered by 4 C-cell batteries, it is also
very portable.

The Kenko SkyMemo Tracking mount with optional tripod

Once you have a tracking mount you must polar-align it. Conceptually, you are aligning the rotational axis of the mount with the rotational
axis of the earth; when they are in perfect alignment, the motor in the mount will perfectly counteract the rotation of the earth. Most mounts
have the option of a polar-alignment scope; a good polar-alignment scope will get you aligned well enough for most wide-field
astrophotography without relying on more precision alignment techniques, such as drift-aligning, which | will not cover here. Precise polar-
alignment is dependent on the tracking mount you purchase. Follow the directions that come with your mount carefully, as excellent
alignment is key to obtaining the best images.

One other important factor in tracking accuracy is balancing your mount; most come with a counterweight system designed for this
purpose. Generally speaking, you want to have the mount slightly out of balance, with more weight to the east side of your mount (facing
the north star, the east side is the right-hand side of your mount). This will ensure that gears always remain tightly engaged, providing
optimal tracking.

Camera and Lenses

The characteristics of your camera are very important for astrophotography. To obtain the best results in your astrophotography, your
camera must have excellent high-ISO performance. In particular, it must be able to handle smooth transitions of low-contrast detail in the
shadow. Historically, this means that Canon’s cameras have reigned supreme with those interested in astrophotography. While this is
likely to change, and some Nikon cameras perform well in this area (the D80, for example), in general all of the Canon digital SLR’s
perform very well and are an ideal choice. The camera also must have a full-manual bulb mode and the ability to connect a timer/remote
shutter release.

Lens choice is very important. It is easy to assume that the best lens is a fast lens, but this is not necessarily true. There is perhaps no
more exacting test of lens quality than astrophotography, where point sources of bright light, defects such as coma, astigmatism and
chromatic aberration are easily exposed. Nearly every lens will need to be stopped down to reduce or eliminate these defects. Excellent
Canon lenses include the following: 24mm f/1.4L (stopped down to f/4), 35mm f/1.4L (stopped down to f/3.2), 50mm f/1.2L (stopped down
to f/4); 100mm /2.8 macro (stopped down to f/3.2); 180mm f/3.5L macro (some corner distortion wide open, excellent above /4), 200mm
f/2.8L (excellent performer at /3.2, perhaps one of the best astrophotography lenses); 300mm /2.8 (good wide open, perfect above /3.2);
500mm f/4 and 600mm f/4 (both very good wide open). The Nikon 180mm /2.8 ED and 300mm /2.8 ED are also highly acclaimed and
produce excellent results; like the Canon lenses, they need to be stopped down a bit for optimal performance. In general,
astrophotography requires the best quality lenses you can use, and even those will likely need to be at least slightly stopped down for the
best results.



Right: Orion, 35mm, 50 minutes, ISO 800 Left: The Belt and Sword of Orion, 135mm, 60 minutes, ISO 800

The focal length of the lens determines the field of view. For astronomical objects, moving closer to adjust framing and field of view is
obviously not an option, so you will need to choose the lens to frame your desired target. For example, 24mm is excellent for wide views of
the Milky Way, 35-50mm is good for framing most constellations in a single shot, whereas 100-600mm should be chosen depending on the
target you want to photograph. To help you choose targets and understand your field of view, you should use a planetarium program such
as Starry Night or Software Bisque’s, The Sky. Both have excellent maps of the night sky and the objects you can photograph, and both
allow you to define the field of view for your camera and lens combinations, helping you choose a lens based on framing of your target.

Basic Requirements for Successful Imaging
Time

Simply going out any night to image will not do - which night you choose is quite important. To get truly dark skies, you need to take your
images at new moon or very close to it. The ideal time window is between the last quarter moon and new moon. If there is any moon at
all, you will want to wait until at least one hour after the moon sets. Similarly, you will want to wait until at least one hour after the sun sets
before you start imaging. The darker the sky, the better the image potential.

Location, Location

Just as in real estate, in astrophotography, location is important. Unfortunately, in most locations we have lost our night sky to pollution.
That is, light pollution. In order to see, and photograph, the night sky, you will need to get to a location with good dark skies. Fortunately,
many of the locations nature photographers like to haunt, particularly the national parks in the western United States, have exceptionally
dark skies. However, the skies must also be clear and relatively transparent (these two are not the same thing: a sky may be clear of
clouds, yet with high relative humidity, the transparency will be low). An excellent resource for determining sky conditions is the Clear Sky
Clock web site. You can use the clear sky clocks to find both a dark location near you as well as the ideal night for astrophotography. The
best nights will be near new moon, at a location far from city lights, with clear, dry skies.

As a general rule of thumb, higher elevations and desert locations are ideal for astrophotography. At higher elevations, you are located
above most of the atmosphere, which greatly increases the transparency. Dry air is also much more transparent. An ideal location is a
high, dry location. This is why the world’s great observatories are located in regions like Chile’s Atacama Desert, the desert southwest of
the United States, and the Canary Islands. That said, any location at higher altitude is better than one at sea level, and in humid locations,
you can always choose an evening with low relative humidity (winters are best for low relative humidity due to temperature).



Since you will need to ensure absolute darkness once you begin shooting your images, the best thing to do is scout out your location
during daylight. Make sure you know what might obstruct your image, such as a tall tree. In particular, you will want to make sure there
are no nearby stray light sources; even a few brief seconds of a porch light or car headlights can ruin an image. Set up your mount and
camera before darkness, so you can clearly see what you are doing. This will also maximize the time you can spend taking images once
night falls.

Acquiring your images

Once you have the right equipment, location and weather, you need to acquire your images. In general, you will want to take multiple
images and electronically combine them. This is beneficial for many reasons. First, the more images you stack, the more you increase the
signal and decrease the noise - more exposures, better images. Second, stacking will allow you to eliminate problems from individual
images, such as airplane trails. And finally, stacking multiple short exposures lets you have less accurate tracking but yet still get good
final images without star trailing. If your camera has a long-exposure noise reduction setting, make sure you turn it off unless you intend to
only take a single exposure; combining images will do an excellent job of cleaning up any noise, and in-camera long-exposure noise
reduction will only decrease the total amount of time you will be able to image your target of interest.

-

Image illustrating flaws: The focus is slightly off; the stars are trailing a small amount
(polar alignment is slightly off), and a plane has flown through the exposure.

Because you will be taking a large number of long exposures, you should have either an AC power source for your camera and mount or a
battery grip. An intervalometer such as the Canon TC-80N3 is a must if you don'’t intend to trip every exposure manually. At a minimum,
you need a remote release to prevent introducing any shake vibration into the images. Some software packages, such as the Canon EOS
Utility and IRIS, will allow you to connect the camera to a computer via a USB cable and use the camera to not only store the images but
also to act as a software intervalometer. If you use a computer, make sure you can dim or turn off the screen. When | use a computer, |
cover the screen with a large dark towel folded over several times to prevent any light from escaping. | recommend taking one exposure
first to make sure your estimated exposure parameters and tracking are fine. | usually download that image to my laptop to examine focus
and tracking closely.

Focus is also extremely critical and can be difficult to achieve. The infinity focus mark on most modern lenses is not truly at the infinity
focus point of the lens. Focusing is most easily achieved with the newer Canon cameras that have the “Live View” function or with the
Canon 20Da, which is a specialized model of the 20D optimized for astrophotography. However, with other cameras you can focus a
number of ways. | recommend letting your eyes adapt to the dark, which requires at least 20 minutes with no lights on at all. Take this
time to enjoy the night sky with a pair of binoculars. You can then manually focus on a very bright planet or star. | often use Venus or
Jupiter in the early evening. Depending on the lens, you might even be able to get the camera to auto-focus on the object. Otherwise, you
can try using a focusing magnifier or a third-party knife-edge focuser. A good method is to try to focus manually or with AF as close as
possible and then take a series of short exposures of a bright star and then examine them closely to fine-tune the focus. If the stars are
well-focused, they will appear as sharp points of light in a long exposure (assuming your tracking is working well), while out of focus stars
look a bit soft and bloated. One way to examine critical focus is to evaluate dim stars - if the image is even slightly out of focus, you will
see it on dim stars first as they will look faint. Once focus has been achieved, make sure you do not bump the focus ring. Make sure auto-
focus is turned off to prevent accidental activation and loss of focus.

Finally, you need to determine exposure settings. These will vary depending on the object you are attempting to image: is it inherently
faint, or is it bright? Exposure time will also vary according to how well your camera mount is tracking. In general, you don’t want to
overexpose the subject, but underexposure is even worse, as the subject is somewhat dim and post-processing will enhance any noise.
Typically, the best thing to do is experiment with a few shots to get the exposure correct, which will also help you frame your subject. You
can use the histogram on the back of the camera to approximate your exposure. As a rule of thumb, you can start with the following



exposures:

f-stop ISO Exposure
28 800 180s
4 800 300s

You can derive exposure times for different ISO settings and f-stops using standard rules of exposure. For example, you might choose to
shoot at ISO 1600 and /3.2, in which case you would want an exposure between 60 and 90 seconds in duration. In general, err to the
longer end of exposure as most objects are faint and a slight overexposure is better for reducing image noise. Remember, however, that
these are only guidelines. If your skies are exceptionally dark, you might be able to shoot a longer exposure than listed. Conversely, if
your alignment on your mount is off, you might choose shoot a shorter exposure to reduce star trailing in your image.

Tests that | and others have done show that most existing digital SLR’s tend to perform optimally at ISO 800 when used for
astrophotography. At ISO 800, the ratio of signal-to-noise is optimal for stacking multiple images and gives the most manageable exposure
times. Dynamic range is also generally still very good at ISO 800, as is color, which often degrades at higher ISO settings.

Once you have completed these steps, you should be ready to begin your imaging sequence. lt is critical that you do not bump the mount,
flash any lights nearby, or even walk near your mount (vibrations can blur the image). | recommend having a nice reclining camp chair and
a pair of binoculars. Trip the exposure sequence and then sit back and explore the night sky.

Post-capture Image Processing
Stacking and Signal-to-Noise Ratios

While processing is perhaps one of the most important steps in any photography, in astrophotography it can safely be claimed that it is the
single-most important step. You can take the best series of images possible, but have an unacceptable final image if you do not know how
to process it. | am assuming that you will shoot all images in RAW mode, as you need every bit of significant data when processing these
types of photos. If you shoot in JPEG, you will be wasting your time and most of your significant data. If you don’t use it already, now is the
time to learn RAW processing.

The essence of processing these images is that you are working to maximize your signal-to-noise ratio. In images shot in normal daylight,
this is not a problem - the signal dominates most of the image and the results look very clean. This is why even a high-ISO shot can look
excellent if the subject is properly illuminated. In the case of astronomical images, the bulk of your image will always be underexposed, so
the signal-to-noise ratio is very low. This limits how much post-processing you can do. Therefore, the best thing you can do is take
enough exposures to maximize your total signal-to-noise ratio. Because the noise is in essence random (not entirely so, but for practical
purposes, it is), stacking has a significant effect on increasing the signal, which is non-random. The signal-to-noise increase from adding
multiple exposures can be calculated with the formula n/SQR(n), where n=number of exposures. Therefore, you can see that taking 4
images and stacking them increases the signal by 200%. In general, the fainter the object you wish to image or the more noise-free you
wish your image to appear, the more images you will need to stack. | find that stacking 10-12 images is usually ideal for all but the faintest
of objects; however, the longer the exposures, the fewer you will need to stack. Conversely, the shorter the exposure, the more you will
need to stack. | generally try to accumulate an additive total of 20 minutes to one hour of exposure time.

Before you can stack your images you need to align them. Your images can be aligned and stacked using a number of different
programs. You can manually align and stack them in Photoshop, or use programs such as Images Plus or Registar to align and stack your
images. The free program IRIS (Windows only) will also work very well. In all cases, you will generally need to open your RAW files and
begin basic processing.

RAW Processing

The RAW converter you use can have a large impact on the quality of your astronomical images. For example, the RAW converter used in
Apple’s Aperture program does a poor job with astronomical images. Because stars are essentially points of light that often cover just a
few pixels of the sensor’s Bayer array, the de-mosaicing algorithm can produce undesirable effects. In the case of Aperture, the RAW
engine creates halos of various colors, although green is the most common color, around stars. | have found that Adobe’s Capture RAW
(ACR) provides the best conversion of astronomical images.

In terms of settings, the best thing to do is to leave all white balance settings, etc. as close as possible to the original and use auto white
balance while acquiring the images. Turn off sharpening and any noise reduction, with the exception of color noise reduction, where it's
best to use as little as possible to reduce chroma-pattern noise. Perform any needed chromatic aberration and vignetting correction on the
RAW files. Set the output to be 16-bit, so you retain as much data from the original files as possible. | make sure that | open all the files
and apply any edits to one, then use the “Synchronize” function of ACR to make sure the same edits are applied equally to all images.

Before you perform any color adjustments, etc, it is best to align and then stack your images. Adjusting individual images at this point can
be tedious and can also have undesired results on the final image.

Aligning and Stacking

If you are going to use a second program to align and stack your images, at this point you will need to save your images. | prefer to use
Registar for stacking and alignment; it is very powerful and simple to use (although the interface is not terribly intuitive, once you learn it, it
is very straightforward). To use the images in other programs, | save them as 16-bit TIFF files, which are nearly universal in their



compatibility.

If you are using Photoshop, stacking is performed by using layers. If your images are all nearly perfectly aligned already, then simply
expand the canvas of one of the images, and paste the other images in as layers. Aligning the images is best performed by selecting the
first pasted layer and then altering the opacity to about 50%. This will allow you to see where the two images overlap. Generally, you
should be able to easily align two images through simple lateral and vertical movements. However, if your polar alignment was not perfect,
the stars in one image will appear rotated relative to the other; this is known as field rotation. This will have to be manually corrected by
using either the Image->Rotate Image->Arbitrary function, or the Edit->Transform->Rotate functions. After you align one image, you will
need to align the next image. | recommend turning the opacity to 0% on each layer after you have rotated it, so you are registering/aligning
each image to only one “master” image. When you are ready to combine, you can perform a simple average in Photoshop by setting the
blend mode on the first layer to “Normal” and the Opacity to 50%.

Aligning and stacking in Photoshop can be tedious. Automated registration programs provide a number of excellent methods of
automatically aligning and combining images with little or no user interaction required (although they may tax the memory and processing
power of your computer). In Registar, after registering all of your images, you should generally combine them all using the Median/Mean
function. Statistically the Median/Mean function will work best, particularly if you have more than roughly eight images that you intend to
combine. The Median/Mean function looks at all pixels in your image and throws out any value in a single image that is within a pre-
determined number of standard deviations from the median value of that pixel in all images and replaces it with the median value for that
pixel. After this step is completed, the Median/Mean function then averages all of the resulting images. This has the advantage of getting
rid of single hot pixels, airplane trails and other effects that are significant deviations from the median, while taking advantage of the optimal
noise-reduction features of a mean combination. Regardless of what program and combination method you use, save the final output from
the third-party program as a 16-bit TIFF file for final manipulation in Photoshop.

Please note that up until now | have not mentioned changing the image in any way, such as via levels, curves, noise reduction, etc. This is
because you should make all of those adjustments on the final image, where the signal-to-noise ratio has been optimized. Note the
difference below between a single image and a stack of nine images; the difference in signal and noise is noticeable. Although the image
on the right looks very clean, absolutely no noise reduction has been performed at this point. The lack of noise is purely a result of stacking
multiple images.

o : ' i Sy “ Effects
of Stacking: The image on the left is a single 2-minute exposure. On the right is a stack of 9 2-minute images. Note how the stacked image
has much lower noise and shows much more detail in the faint nebula, as well as more stars. This is particularly noticeable in the blue

channel, which has the lowest sensitivity on the CMOS sensor.
Finally...an Image: Final Processing

Once you have the final stacked image, you can proceed with normal processing. However, astronomical images are not analogous to
most other images and therefore need special processing. With astronomical images, you will often have a final image that has a black
background that does not appear black; the object of interest may be very faint and the white balance/color balance is typically wrong. You
need to carefully correct all of these problems and then work with the data to extract as much detail without introducing artifacts.

The first thing that you should do is correct the color balance. Typically, the AWB setting of the camera will get your image close to the



correct color; however, it tends to be deficient in blue, because the sensor is least sensitive to the blue part of the spectrum. Interestingly,
even though the filters in front of the sensor are designed to prevent any IR light from reaching the sensor, therefore cutting into the visible
red spectrum, the white balance of astronomical images tends to be shifted slightly toward the red. Luckily, these color imbalances are not
too difficult to correct: we can simply pick a dark part of the sky and use the color picker to see and correct the color imbalance.

The goal is to do as many of your adjustments as possible in a non-destructive fashion. If you have Photoshop CS2 or CS3, you can do
this using Adjustment Layers. Select Layers-> New Adjustment Layer-> Color Balance. Name your layer appropriately. Now, using the
color balance sliders and the picker tool to sample a uniform dark area of the image, we can adjust the levels of the colors to correct for
any imbalance. Below | have selected a random spot in the image. On the left is the uncorrected version and on the right is the version
with near perfect color balance across RGB after adjusting with the color balance tool. When using the tool, the RGB levels will show the
current values on the left and the new values directly under them, after a “/” symbol. Use the RGB values to correct your image; ignore the
CMYK values. We are working with an RGB image.
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Click iImage to choose new foreground
color. Use Shift, Opt and Cmd for
additional options.

Click image to choose new foreground
color. Use Shift, Opt and Cmd for
additional oprions.

Example of color balance adjustment using a patgh of black sky. It should be neutral after adjustments
have been performed, as is shown on the right. Before adjustment, the image is too red and is deficient in the blue channel.

Once the color balance has been corrected you will want to adjust the levels just a bit to start out, with full levels adjustments coming later.
Looking at the histogram, you should find the data in a tight curve, all bunched near the middle. We want to clip off the ends that contain
no data, both on the dark and light sides, and then stretch the data in the middle, to provide more differentiation between the faint objects in
the image. The best way to do this is to adjust the levels slightly using an adjustment layer in Photoshop. As with color balance this will be
a non-destructive edit. After adjusting the levels, you will want to make a non-linear adjustment to the curves. This will stretch out the data
to provide differentiation between very faint objects and the background. We want to be careful to not go too far here; the more we stretch,
the more noise we will reveal. If you have a good image that is the result of stacking adequate exposures, you should be able to stretch
the image fairly far without exposing significant noise.

Create a layer for curves just like you did for color balance. Generally you will want to produce an S-shaped curve similar to the one shown
below. It will require at least three points, but you can use more to achieve your desired effect.
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eaple of nn-/inar curves adjustment. Note how the S-curve makes the background dark
and keeps the highlights from blowing out, all while bringing out mid-tone detail.

Once you are satisfied with the results, you can go back and make final adjustments to the levels. Below we can now see how the non-
linear curves adjustment has spread out the levels. Note the smooth curve; we have not clipped any data within the data set; however, we
have slightly clipped a small part of the highlights. This is indicated by the small peak on the right-hand side of the curves that is cut off. In
images like this it is not uncommon. Generally what you are seeing is the very brightest stars being pushed to the point they are blown
out. Visually this is perfectly acceptable. You may wish at this point to adjust the black point to make the sky dark, which will also hide
noise in the dark areas where it is most prevalent. You may also wish to adjust the midpoint to further enhance the dim areas without
losing any more highlight detail.
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Levels after a non-linear curves adjustment.

Input Levels:

Like any other image you may now want to tweak the saturation or sharpening. In general, | recommend doing these adjustments with
layers as well. This will allow you to selectively blend the results into the final product. Typically a slight increase in saturation is required,
as most cameras have low color saturation at high ISO settings. As for sharpening, | tend to avoid sharpening except after reducing the
image to web size (I recommend using Smart Sharpen, set to 0.3 radius, 60%). Because of the point nature of the stars, it is very hard to



not introduce either halos or a generally unnatural appearance when sharpening. If you have imaged a large diffuse nebula, you may find
that the stars become too numerous and bright after your non-linear curves adjustment. This can be addressed by creating a new Layer
via Copy. Apply a Minimum Filter to this new layer and then a slight Gaussian Blur. This will remove the stars while leaving the nebula
intact; you can then merge this with the main image by reducing the Opacity to about 50% or less and using Normal blending mode. You
will notice a marked increase in the intensity of the nebula and a corresponding decrease in the intensity of the stars. Incidentally, this is
the same basic technique applied in an unsharp mask (your blurred/filtered image is actually an unsharp mask, from which the process
name is derived), so it will also gently sharpen your image.

At this point, if you are satisfied with the results, you can create your final image. Since you have performed all of your work in layers, you
must flatten them for the final image. Generally speaking, the best method to do this is to set the blending mode to Normal and the Opacity
to 100%. However, you may choose to adjust the opacity or to try a different blending method.

There are many more complex steps you can take from here. For example, many objects, such as galaxies have a tremendous dynamic
range and a simple non-linear curve cannot properly display both the bright and dark areas of the image. In these cases, creating layer
masks and adjusting individual parts of the image can produce your desired results. Your skills with Photoshop will be your primary
limitation, but you may also choose to take sets of exposures of an object of differing duration. A common practice when imaging galaxies
with bright cores, or nebula with bright cores is to take two sets of exposures of different durations: one optimized for the bright areas and
one for the faint areas. There is lots of room to experiment and many celestial objects you can experiment with.

Astrophotography is a fascinating area to explore, and as you can see, does not require the purchase of telescopes or special cameras.
The simple addition of a tracking mount can open up a whole new selection of subjects and give you some solitude under the stars.
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Jeff Hapeman has his formal education in Botany and Evolutionary Biology, but left the study of the sciences to found an IT consulting firm
in the late 1990’s. After selling his company in 2003, he returned to a love he had first discovered as a young boy about 25 years ago:
nature photography. With the new digital age, Jeff found a way to combine his love of technology with his love of nature and photography,
and has gradually moved into photography as a serious hobby. While his interests are broad, he has a special fondness for shooting
images at night, including the stars and aurora. He lives in Los Angeles with his wife and young daughter and currently is the CTO of a
investment analytics firm.

Feel free to send your comments on this article to the editors at NatureScapes.Net.
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